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1
Welcome.
Let’s Get Started.
Welcome to the User Manual for the MakerBot®
Replicator® Desktop 3D Printer (Fifth Generation
Model). The fifth generation MakerBot Replicator
is super easy to use, but it’s also packed with
brand-new features, so even if you’ve used a
MakerBot Desktop 3D Printer before, be sure to
read this manual all the way through.

safety and compliance

Now, before we get going, let’s review some important safety information.

RADIO AND TELEVISION INTERFERENCE
This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant
to Part 15 of the Federal Communications Commission (FCC) rules. These limits are designed to
provide reasonable protection against harmful interference in a residential installation. This equipment
generates, uses and can radiate radio frequency energy and, if not installed and used in accordance
with the instructions, may cause harmful interference to radio communications. However, there is no
guarantee that interference will not occur in a particular installation. If this equipment does cause harmful
interference to radio or television reception, which can be determined by turning the equipment off and on,
the user is encouraged to try to correct the interference by one or more of the following measures:
• Reorient or relocate the receiving antenna.
• Increase the separation between the equipment and the receiver.
• Connect the equipment to an outlet on a circuit different from that to which the receiver is connected.
• Consult the dealer or an experienced radio/TV technician for help.
You may also find helpful the following booklet, prepared by the FCC: “How to Identify and Resolve
Radio-TV Interference Problems.” This booklet is available from the U.S. Government Printing Office,
Washington, D.C. 20402.
Changes and modifications not expressly approved by the manufacturer or registrant of this equipment
can void your authority to operate this equipment under FCC rules.
MANUFACTURER
MakerBot Industries, LLC
One MetroTech Center, 21st Floor
Brooklyn, NY 11201
347.334.6800
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safety and Compliance

Safety alert symbols precede each safety message in this manual. These symbols indicate
potential safety hazards that could harm you or others or cause product or property damage.

Warning: The MakerBot Replicator generates high temperatures. Always allow the
MakerBot Replicator to cool down before you reach inside.
Warning: The MakerBot Replicator includes moving parts that can cause injury.
Never reach inside the MakerBot Replicator while it is in operation.
Warning: There is a risk of shock. This product is not user serviceable.
Warning: Do not leave the MakerBot Replicator unattended during operation.
Caution: Do not print using materials that have not been approved by MakerBot for
use with the MakerBot Replicator. Refer to the Specifications section on page 52 for
more information.
Caution: The socket outlet must be located near the equipment and must be
easily accessible.
Caution: In case of emergency disconnect the MakerBot Replicator from the
wall socket.
Caution: The MakerBot Replicator melts plastic during printing. Plastic odors are
emitted during this operation. Make sure to set up the MakerBot Replicator in a wellventilated area.

6

Welcome, let’s get started

About the MakerBot Replicator
How It Works
The MakerBot Replicator makes solid, three-dimensional objects out of melted MakerBot
PLA Filament. First, use MakerBot Desktop to translate 3D design files into instructions for the
MakerBot Replicator. Then transfer those instructions to the MakerBot Replicator via USB drive,
USB cable, or your local network. The MakerBot Replicator will melt MakerBot PLA Filament
and squeeze it out onto the build plate in thin lines to build your object layer by layer. This
method of 3D printing is called fused deposition modeling.
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About the MakerBot Replicator
MakerBot Replicator Diagrams
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6. Filament Drawer
7. Filament Spindle
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Getting Started
When you set up your MakerBot® Replicator®
Desktop 3D Printer, remember that it was built
and packaged very carefully at the MakerBot
factory. We hope you’ll take your time and be
just as careful unpacking it and getting it set up.

accessory checklist
The accessory tray includes everything you need to use your MakerBot® Replicator® Desktop
3D Printer, including enough MakerBot PLA Filament and blue tape to get you started. To order
more MakerBot PLA Filament or blue tape, go to store.makerbot.com

1

1

MakerBot Product Safety
Information booklet

1

MakerBot Replicator
Smart Extruder

5

Large MakerBot PLA
Filament spool [2 lb]
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Blue tape

Getting started

1

1
Power cord

Build plate

1
USB A-to-B cable

Unpacking the MakerBot Replicator
1

Open the Box

Open the box containing your MakerBot
Replicator and remove the accessory tray.

2	Remove the MakerBot Replicator
Remove the MakerBot Replicator
from its plastic bag and set it down
on a stable surface.
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Unpacking the MakerBot Replicator
3	Remove packaging material
Remove the foam pieces holding the
gantry and extruder carriage in place.

4	Remove clips

Remove the clips that prevent the build
platform from moving during shipping.
Save these – they will be handy if you
ever need to transport your MakerBot
Replicator in the future.
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Setting Up the MakerBot Replicator
1	Install the MakerBot Replicator Smart Extruder
Locate and unwrap the Smart Extruder
and press it against the back of the extruder
carriage, with the connector pins facing
the extruder carriage. Magnets will lock
the Smart Extruder into place.
Note: If you need to install the
Smart Extruder again at any time,
go to the control panel and select
Utilities > System Tools > Attach
Smart Extruder.

i

Caution: Never remove the MakerBot Replicator Smart Extruder from your MakerBot
Replicator during or immediately after printing. Always allow the Smart Extruder to cool
completely before removing it from the 3D printer.

2	Install the spool of MakerBot PLA Filament

2a. Locate the MakerBot PLA Filament spool
and remove it from its plastic bag.
2b. Grasp the back section of the frame of
the MakerBot Replicator and pull upwards to
open the filament drawer. Open the drawer
all the way.
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Setting Up the MakerBot Replicator
2	Install the spool of MakerBot PLA Filament

2c. Position the filament spool so that it will
unwind counterclockwise and fit the spool
onto the filament spindle. Be careful not to let
the filament loosen or tangle on the spool.
2d. Locate the free end of the spooled
filament and insert it into the filament
guide tube at the upper right corner of
the filament drawer.
2e. Push filament through the tube until the
free end emerges from the end of the guide
tube where it is taped to the gantry.
2f. Hold the filament drawer open and
depress the latch. Then slide the filament
drawer closed. Windows in the front of the
drawer will let you see how much filament
you have left.
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Setting Up the MakerBot Replicator
3	Apply blue tape to the build plate

3a. Remove the build plate and one sheet
of blue tape from the accessory tray.
3b. Peel back about an inch of the tape’s
backing and orient the tape so that it covers
the entire build plate.
3c. Press the exposed tape along one edge
of the build plate. Continue to pull away the
tape’s backing and smooth the tape down
until the build plate is completely covered.
3d. Slide the build plate into the slots on the
build platform.

Note: The blue masking tape used by house painters makes a great surface on which
to print objects in PLA. You can find additional build plate-sized sheets of blue tape at
makerbot.com/store or get rolls of blue tape from any hardware store.

i
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Setting Up the MakerBot Replicator
4	Plug in and power on

4a. Make sure the power switch
is in the Off position.
4b. Locate the power cord and plug
it into the power input port at the back
of the MakerBot Replicator.
4c. Plug the power cord into
an electrical outlet.
Caution: The socket outlet must
be located near the equipment and
must be easily accessible.

4d. Switch the power on and press
the control panel dial.
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Power On
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Startup
The first time you turn on your MakerBot® Replicator®
Desktop 3D Printer, the LCD screen will start a setup
assistant that will introduce you to the control panel,
walk you through loading filament and leveling your
build plate for the first time, and prompt you to print a
preloaded example print. Press the dial to get started.

The MakerBot Replicator Control Panel
The MakerBot® Replicator® is operated by means of a control panel
at the upper right of the machine. The control panel includes a color LCD screen,
a rotary/push dial, and two buttons.

1

2

3

4

1. LCD screen

4. Dial

2. Menu button

5. USB drive port

5

3. Back button

•
•
•
•
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•
•
•
•

Turn the dial to scroll through the available options on a screen.
Press the dial to make a selection.
Press the back button to return to the previous screen or cancel an action.
Press the menu button to open a menu with additional options. If a menu is 		
available, a menu icon will appear at the lower right corner of the screen.

startup

First Steps
Level the Build Plate

The build plate is the base on which your prints will form. In order to ensure that your prints
always stick to the plate, it must be a set distance from the nozzle of the MakerBot Replicator
Smart Extruder. The MakerBot Replicator will guide you through making sure your build plate
is at the right distance from the extruder.

Right
leveling
knob
Front leveling knob

During the leveling process:
• • Turn the front leveling knob to change the angle of the build plate from front to back.
• • Turn the right leveling knob to change the angle of the build plate from side to side.
• • When directed, turn the leveling knobs slowly until a light appears on the extruder.
• • Press the control panel dial to move to the next step of the leveling process.
The extruder will move to different points around the build plate to make sure the plate is at
the appropriate distance from the Smart Extruder nozzle. Turn the leveling knobs according
to the instructions that appear on the LCD screen.

i
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Note: You can access the leveling process at any time by choosing the Utilities menu on
the control panel’s home screen and then selecting Level Build Plate.

startup

First Steps
Load Filament
Your MakerBot Replicator uses 1.75 mm diameter PLA filament to create 3D printed objects.
Once your spool of MakerBot PLA Filament is loaded into the filament drawer at the back of
the MakerBot Replicator, all you have to do is load the free end of the spooled filament into
the MakerBot Replicator Smart Extruder.
1. Press the control panel dial.
2. When the Smart Extruder is fully heated,
grasp the top of the extruder assembly and
push the free end of filament into the loading
tube at the top of the Smart Extruder . Keep
pushing on the filament until you feel the
Smart Extruder pulling it in.
3. Wait until you begin to see plastic
emerging from the extruder nozzle. Then
press the control panel dial to stop extrusion.
4. Wait a moment for the Smart Extruder
plastic to cool, then pull it away from the
Smart Extruder. Do not touch the nozzle;
it may still be hot.
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First Steps
Print a Test Object
Now that you’ve leveled your build plate and loaded filament into the extruder, you’re ready
to print something. The LCD panel will display some of the print files loaded onto your 3D
printer’s internal storage.
1. Use the dial to highlight one of the print files.
2. Push the dial to select your chosen print.
You will be taken to a file info page.
3. Select Print. The MakerBot Replicator
will print the file you selected.
4. When the print is finished, let it cool
before removing it from the build plate.

Caution: Never turn off the MakerBot Replicator immediately after completing a print.
Always allow the Smart Extruder to cool before powering down.
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First Steps
connect to your computer
There are three ways to move files from your computer to your MakerBot Replicator: USB
cable, Ethernet, and USB drive.
To connect via USB cable:
1. Remove the USB cable from the accessory box.
2. Insert the USB-B end of the cable into the port on the back of your MakerBot Replicator
and insert the USB-A end of the cable into a USB port on your computer.

To connect via Ethernet:
1. Locate an Ethernet cable (not included).
2. Connect one end of the cable to the Ethernet port at the back of the MakerBot Replicator.
Connect the other end to a wall jack or router used by your local area network.

To connect via USB drive:
No additional setup is required. See Chapter 4 for instructions on exporting print files.
Once you’re connected, download MakerBot Desktop to complete setup of your MakerBot
Replicator.

i
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Note: Your MakerBot Replicator 3D Printer is also set up for built-in Wi-Fi connectivity.
We will be enabling onboard Wi-Fi with a firmware update soon.

startup

4

Makerbot desktop
MakerBot® Desktop is a free app for preparing 3D
prints and managing your 3D content. Whether you
print directly to the MakerBot Replicator® Desktop
3D Printer via USB cable or Ethernet or you export
your print files to a USB drive, MakerBot Desktop is
where all of your prints will begin.

downloading and installing makerbot desktop
1. Open a browser session and go to makerbot.com/desktop.
2. Select your operating system from the dropdown menu and click Download.
A system-specific installer will download to your computer.
3. Double-click the MakerBot Desktop installer to run the installation wizard.
Follow the installation instructions.
4. When you open MakerBot Desktop for the first time, you will be asked to log in.
• •
•
• •
• •

If you have a MakerBot Thingiverse™ account or a MakerBot Store account,
you already have a username and password. If not, you can create one now.
This is your MakerBot account, and you can use it to log into MakerBot Desktop,
Thingiverse, and other MakerBot sites.
You can use MakerBot Desktop without logging in, but logging in will allow you to
access your MakerBot Cloud Library and additional features in the Explore, Prepare,
and Store sections.

5. Select how you will connect your MakerBot Replicator to your computer.
• •

• •
•

If you will connect via USB, ensure that your USB cable is connected to your
MakerBot Replicator and to your computer. MakerBot Desktop will automatically
detect your MakerBot Replicator. Give your MakerBot Replicator a name and
choose whether or not you will sync your MakerBot Cloud Library to proceed.
If you will connect via LAN, ensure that an Ethernet cable is connected to your
MakerBot Replicator and to a wall jack or router. MakerBot Desktop will automatically
detect your MakerBot Replicator. Choose your MakerBot Replicator from the list
of MakerBot 3D printers on your network. Give your MakerBot Replicator a name and
choose whether or not you will sync your MakerBot Cloud Library to proceed.
If you will print only via USB drive, click Skip. You will be asked to choose
a MakerBot 3D printer. Choose Replicator (Fifth Generation).

• •
•
•
You can change which method you use to connect to your MakerBot Replicator at any time.
You’re now set up and ready to print!

25

makerbot desktop software

printing from makerbot desktop
How It Works
MakerBot Desktop consists of four sections: Explore, Library, Prepare and Store.
Explore gives you access to Thingiverse and the hundreds of thousands of 3D printable
objects designed by the Thingiverse community. Use Explore to search Thingiverse for
inspiration or new things to print, then save them to your collections or prepare them
for printing.
Library gives you access to your MakerBot Cloud Library and helps you organize your
3D model files. Use it to access things you’ve collected on Thingiverse or bought from
the MakerBot Digital Store as well as your own models.
Prepare is where you will turn 3D models into print files. Bring 3D models into the Prepare
screen to manipulate them on a virtual build plate. Then specify print options and send print
files to your MakerBot Replicator.
Store lets you buy print files for premium 3D models. The MakerBot Digital Store sells
original, fun, and collectible digital content specifically designed for MakerBot Replicator
Desktop 3D Printers. When you buy a model in the MakerBot Digital Store, a print file for your
MakerBot Replicator will be added to your MakerBot Cloud Library.
Use Store and Explore to find 3D models, Library to keep them organized, and Prepare to
send them to your MakerBot Replicator for printing.
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printing from makerbot desktop
finding a 3d model
Every 3D print starts with a 3D model. If you design a 3D model yourself, export it from your
3D modeling application in STL or OBJ format. If you don’t have a 3D model, download one
from Thingiverse, either through the website at thingiverse.com or through the Explore tab
in MakerBot Desktop.
•
• • To open a model from Thingiverse, go to the Explore tab, locate the Thing you want 		
to print, and click Prepare to open it in the Prepare tab.
• • To open a model saved in your Library, go to the Library tab and select a folder to
browse. Mouse over a list item to show a menu icon. Click the icon and select 		
Prepare to open the model in the Prepare tab.
• • To open a file saved to your local computer, go to the Prepare tab, click Add File, and
•
navigate to the location of the saved file. Select the file and click Open to import it 		
into MakerBot Desktop.
Let’s download an example object through the Explore tab.
1. Click Explore tab at the top of the MakerBot Desktop screen.
2. Type “Queen Anne coffee table” into the search bar and press Enter. One of the results
will be Miniature Queen Anne Coffee Tables. Click the image to go to the Thing page.
3. On the Miniature Queen Anne Coffee Tables page, click Prepare.
4. You will be shown a list of available files. Next to each listed file is a Prepare button. Click
Prepare next to the QA_CoffeeTable_Rect.stl file. MakerBot Desktop will download your file
and open it in the Prepare tab.
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printing from makerbot desktop
preparing to print
You should now see the Queen Anne coffee table model at the center of a gray rectangle.
This is MakerBot Desktop’s representation of your 3D printer’s build plate. Let’s take a look at
the other features visible on the Prepare screen.

1

7

8

9

10

11

2
3
4
5
6
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1. +/–
• • Click the Plus and Minus buttons to zoom in and out.
• • You can also zoom using a track pad or the scroll wheel on your mouse.
•
2. Home
• • Click the Home button to reset MakerBot Desktop to the default view of the build plate.
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printing from makerbot desktop
3. View
• •
• •
• •
• •
•

Click the View button or press the V key to go into View mode.
In View mode, click and drag with your mouse to rotate the build plate.
In View mode, hold the Shift key and click and drag with your mouse to pan.
Click the View button again to open the Change View submenu and access
preset views.

4. Move
• • Click the Move button or press the M key to go into Move mode.
• • In Move mode, click and drag with your mouse to move your model around on the 		
build plate.
• • In Move mode, hold down the Shift key and click and drag with your mouse to move 		
your model up and down along the z-axis.
• • Click the Move button again to open the Change Position submenu and center your 		
object or move it by a specific distance along the x-, y-, or z-axis.
5. Turn
• • Click the Turn button or press the T key to go into Turn mode.
• • In Turn mode, click and drag with your mouse to rotate your model around the z-axis.
• • Click the Turn button again to open the Change Rotation submenu and lay your 		
object flat or rotate it by a specific number of degrees around the x-, y-, or z-axis.
6. Scale
• • Click the Scale button or press the S key to go into Scale mode.
• • In Scale mode, click and drag with your mouse to shrink or enlarge your model.
• • Click the Scale button again to open the Change Dimensions submenu and scale 		
your object by a specific amount along the x-, y-, or z-axis.
7. File Name
• • The file name bar displays the name of the file or layout currently open. Thing files 		
can include multiple layouts, or arrangements of models on the plate.
8. Settings
• • Click Settings to open the settings dialog.
• • Use the dialog to change print settings for the current object or layout.
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printing from makerbot desktop
9. Add File
• • Click Add File to open an Open File dialog.
• • Navigate to the location of any STL, OBJ, or Thing file and select the file to add a 		
model to the build plate.
• • You can add as many models to the plate as will fit. Use the keyboard shortcut
•
Ctrl/Command + L to automatically arrange multiple models on the plate.
• • Duplicate models already on the plate using the Copy and Paste options in the
•
Edit menu or the keyboard shortcuts Ctrl/Command+C and Ctrl/Command+V.
10. Save
• • Click Save to open a Save dialog.
• • If you are logged into your MakerBot account, you can choose to save an STL or
•
Thing file to your Library or to your local computer. See makerbot.com/support for
•
more information on your MakerBot Cloud Library.
• • If you are not logged into your MakerBot account or if you are working offline, you 		
will be able to save your file only to your local computer.
• • If you are working in an existing Thing file, you can rearrange the models on the plate
•
and save this new layout to the Thing file without overwriting earlier layouts.
11. Print
• •
• •
•
• •

Click Print to send a print file to your MakerBot Replicator.
If MakerBot Desktop is not connected to your MakerBot Replicator, use the
Print button to export a print file.
You can also print or export print files by going to the File menu and choosing Print 		
or Export > Export Print File.

12. Status
• • The status bar displays the connection status of any connected MakerBot 3D Printer.
• • It also displays print progress.
• • Click to open a print monitor panel.
• • The print monitor panel displays more detailed information about any connected 		
MakerBot 3D Printer and a camera view of any print in progress.
The Queen Anne coffee table model should print well at its default size and position,
but you can also choose to manipulate it before proceeding.
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print settings
If you want to change any settings before printing, click Settings. This is where you can specify
options that will affect the quality of your printed object, like print resolution and object strength.
To print with standard or previously specified settings, skip this step and go straight to printing.
1. Resolution
Choose Low, Standard, or High resolution
to specify the surface quality of your 3D print.
• •	Objects sliced with the Standard
resolution profile will be printed
using the default settings.
1
Standard resolution prints will
5
print quickly and have good
surface quality.
• •	Objects sliced using the Low
resolution profile will be
•
printed with thicker layers
•
and will print faster.
• •	Objects sliced with the High resolution profile
•
will have finer layers and will print more slowly.

2
3

4

For this print of the Queen Anne coffee table, select Standard.
2. Raft
Select this checkbox to have your object built on a raft. The raft acts as a base for your object
and any support structures, and ensures that everything adheres well to the build plate. The
raft will be easily removable once you remove your finished object from the build plate. For
this print of the Queen Anne table, make sure the Raft checkbox is selected.
3. Supports
Select this checkbox to have your object printed with support structures. MakerBot Desktop will
automatically generate supports for any overhanging sections of your object. Supports will be
easily removable once you remove your finished object from the build plate. You will not need
support structures to print the Queen Anne coffee table, so make sure the box is not checked.
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printing from makerbot desktop
print settings
4. Advanced
Click Advanced for additional options, including temperature and object strength. For information
on what the advanced settings are and how to use them, go to makerbot.com/support. You
will not need to change any advanced settings to print the Queen Anne coffee table.
5. Cancel
Click Cancel to return to the Prepare screen without saving changes. Any print settings you
have selected will be discarded.
6. Save Settings
When you are finished, click Save Settings. The current settings will be used to slice your
model next time you print or export a print file.

printing to the makerbot replicator
When you are ready to print the Queen Anne coffee table model, click Print to slice the model
using the current settings and send a .makerbot print file to your MakerBot Replicator.
• •
• •
•
• •
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If MakerBot Desktop is connected to your MakerBot Replicator, the print file will be
sent directly to your 3D printer. Click the control panel dial to confirm and start your print.
If MakerBot Desktop is not connected to your MakerBot Replicator, this button will open
a dialog allowing you to save a .makerbot print file. You can transfer the print file to
your MakerBot Replicator using a USB drive or print it from your Library at a later time.
Click Print Preview to open a preview of the sliced model.

makerbot desktop software

Camera
A feed of images from the onboard camera is always available when you’re connected to your
MakerBot Replicator. To view the feed, click the menu icon at the right side of the status bar to
open the monitor panel. As long as you are connected to your MakerBot Replicator via a local area
network, the camera image will refresh every few seconds.
When you connect your new MakerBot Replicator to MakerBot Desktop for the first time, the
camera image may be blurry. You will need to focus it manually to get the best image possible.

To focus the camera:
1. Connect the MakerBot Replicator to MakerBot Desktop using a local area network and click
the status bar to open the monitor panel.

2. Locate the camera. It is mounted inside the right front corner of the MakerBot Replicator.
3. Grasp the plastic ring around the lens and twist it slightly. Avoid touching the camera lens
itself.
4. Check the camera feed and wait for the image to refresh. If the image is clearer than it
was before, continue twisting the lens in the same direction. If the image is less clear, start
twisting the lens in the opposite direction.
5. Twist in small increments, and check the camera feed frequently. When the image is clear
and twisting in either direction makes it more blurry, stop making adjustments. You have
successfully focused the onboard camera.
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The Control Panel
The control panel on your MakerBot® Replicator®
Desktop 3D Printer allows you to interact with
your 3D printer. You can use it to initiate prints,
edit settings, and access information. This chapter
describes the different things you can do with the
control panel.

home screen
Use the control panel to:
• •	Print objects from a USB flash drive or the internal storage of
your MakerBot Replicator.
• • Start prints initiated via MakerBot Desktop.
• • Change printer settings.
• •	View print history and statistics.
1

2

3

4

5

6

1. Print: Initiate a print stored on a USB drive or internal storage, or synced from your
MakerBot account.
2. Filament: Load filament into or unload filament from the MakerBot Replicator Smart Extruder.
3. Preheat: Preheat the Smart Extruder.
4. Utilities: Access build plate leveling, diagnostics and other tools.
5. Settings: Edit network and sharing settings and personalize your MakerBot Replicator.
6. Info: View your 3D printer’s history and statistics.
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Print
Select the Print icon to initiate a print stored on a USB flash drive or on your 3D printer’s
internal storage.

1

select a file

Turn the dial to scroll through the list of
available locations. Push the dial to select
the location of the file you want to print.
Select USB Storage to print a file stored on
a USB drive inserted into the USB port.
Select Internal Storage to print a file stored
on the MakerBot Replicator. The internal
storage has a capacity of about 2 GB.
Select Your Library to print a sliced file from your MakerBot Cloud Library. In the Library menu:
• •
• •
• •
• •

Choose All Things to access every item synced to your MakerBot Replicator
from your Library.
Choose My Designs for private files synced from your MakerBot Cloud Library.
Choose Thingiverse for items from your MakerBot Thingiverse™ collections.
Choose Purchased for files purchased from the MakerBot Digital Store.

Press the dial to select a location. Turn the dial to scroll through the list of available files and
press it again to select one.
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print
2	Start Print
• •
• •

If you select a file from the USB drive or internal storage, the control panel will
display the file screen.
If you select something from your MakerBot Cloud Library, you will see a list of all
the layouts associated with the file. Scroll through the available layouts and select
one in order to go to the file screen.

From the file screen, choose what to do
with the part or layout:
• • Select Print to start printing the file.
• • Select Info for more information
on the part or layout. Turn the dial
•
to toggle between three 		
information screens.
• • Select Copy to copy a file to
•
internal storage or to an attached
USB drive.
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print
Printing
During a print, you will be able to view
print progress information as well as
other details about your print.

1

1. Percentage of the print completed.
2

2. Time elapsed and estimated time
remaining in the print. While the Smart
Extruder is heating, this area will display
the current and target temperatures.
3. Location in active print screens. Turn the
dial to scroll between the following screens:
• •
• •
• •
••

3

Print progress
Rendering of your model or layout
File information
Print options information

4. Print Menu. Press the control panel’s Menu button to open the Print menu. The
Print menu contains the following options:
• •	
Pause. Select this option to temporarily pause your print. You can also
pause by pressing the control panel dial.
• • Change Filament. Select this option to pause your print and go directly
•
to the Filament menu.
• • Take a Picture. Select this option to take a picture of the build area with
•
the MakerBot Replicator Desktop 3D Printer’s built-in camera. The picture
•
will be saved to internal storage.
• • Set Pause Height. Select this option to set your print to pause at
•
a predetermined height.
• •	
Cancel. Select this option to cancel your print. You can also cancel a print
by pressing the back button.
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4

print
3	Print complete
If you are printing a file from Thingiverse, you will be prompted to share a photo. Photos
shared to Thingiverse will appear on the Thing page in the I Made One! section. Sharing a
photo is a nice thing to do – other Thingiverse users will love to see how your prints of their
designs come out.
To share a photo, select Share to Thingiverse. The MakerBot Replicator will take a
photograph of your build area. Push the dial again to post the photo to the Thing page.
If you do not wish to share a photo of your print to Thingiverse, select Back to Menu.
The MakerBot Replicator will send a photograph to the Print History section of your
MakerBot Cloud Library.
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Filament
Select the Filament icon to load or unload filament.

To load filament:
1.

1. Use the dial to select Load Filament.

2.

2. Wait for the Smart Extruder to heat.

3.

3. Cut the end of your filament to create a clean edge.

4.

4. Grasp the top of the extruder assembly and push the filament into the Smart
Extruder’s loading tube until you can feel the motor pulling the filament in.

5.
To unload filament:
6.

1. Use the dial to select Unload Filament.

7.

2. Wait for the Smart Extruder to heat.

8.

3. Allow the Smart Extruder to unload the filament.

9.

4. When the Smart Extruder has stopped pushing the filament out, gently pull the
filament free. If you are changing filament spools, be careful to keep the spool tightly
wound as you pull the filament free of the guide tube. If you do not, the filament could
unravel or tangle on the spool.
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preheat
Select the Preheat icon to preheat your Smart Extruder. When you select Preheat, the Smart
Extruder will immediately start heating. The current and target temperatures will be visible
on the main screen.

Utilities
Use the Utilities menu to access plate leveling, diagnostics and other tools.
Level Build Plate
Select to begin the assisted leveling process. For best results when leveling, make sure
the extruder nozzle is clean and wipe any plastic debris off of the build plate.
Camera
Select to access options related to your 3D printer’s built-in camera. In the camera menu, you can:
•
•
•
•
•
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•
•
•
•

Take a photo of the build area using the built-in camera.
Browse photos taken by the built-in camera.
Copy photos to the USB drive.
Erase all photos taken with the built-in camera to date.

the control panel

Utilities
system tools
Additional options are available under System Tools.
Home Position
Select to move the build platform and extruder assembly to their home positions. The build
platform will move all the way down and the extruder carriage will move to the front left
corner of the MakerBot Replicator.
Attach Smart Extruder
Select for assistance in attaching the MakerBot Replicator Smart Extruder.
Diagnostics
Select to run a diagnostic sequence or to copy recent diagnostics logs to the USB drive.
If the diagnostic sequence flags any issues, please contact MakerBot Support by emailing
support@makerbot.com
System Logs
Select to clear the MakerBot Replicator’s log files or copy them to a USB drive.
Restore Factory Settings
Select to return all settings on your MakerBot Replicator to the factory defaults.
Power Off
Select to turn your MakerBot Replicator off. After you turn the MakerBot Replicator off by
selecting this option, you will be able to turn it back on by pushing the control panel dial.
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settings
Use the Settings menu to edit network and sharing settings and to personalize your
MakerBot Replicator.
Network Settings
• • Network Info. Select for information about your network connection.
MakerBot Account
• • Unlink Account. Select to unlink your MakerBot account from the MakerBot
•
Replicator. You will not be able to share to Thingiverse or print items from your 		
MakerBot Cloud Library when logged out.
Other Settings
• • Name. Select to change the name used to represent your MakerBot Replicator.
• • Sound. Select to turn nonessential sound effects off or on.

43

the control panel

Info
Use the Info menu to view your 3D printer’s history and statistics.
Firmware
View the version number of the firmware currently installed on your MakerBot Replicator.
HARDWARE
Select to view machine serial numbers, network ID and the current temperature of the
MakerBot Replicator Smart Extruder.
Statistics
Select to view printing statistics, including total print time and the amount of space available
in internal storage.
History
Select to view recently printed items. Select an individual item from the list to view the date,
print time, and quantity of filament used. Press the menu button to change the order of the
listed items or to export the list to a CSV file that can be saved to a USB drive.
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Troubleshooting
As you get to know your MakerBot® Replicator®
Desktop 3D Printer, you may run into issues with
different parts of the printing process. Here is a
handy guide to some simple-to-fix problems. For
help with issues not covered in this chapter, go to
makerbot.com/support or contact the MakerBot
Support team by emailing support@makerbot.com

Printing Problems
Problem	

Solution

Can’t load filament into the
MakerBot® Replicator®
Smart Extruder.

Try unloading and loading again. Hold the Smart
Extruder in place and try pushing the filament
through. As long as you are holding the Smart
Extruder in place, pushing on the filament will not
damage it.

Can’t remove filament from
the MakerBot Replicator
Smart Extruder.

Try running the filament load script and allowing
plastic to extrude for a few seconds. Then try
unloading again.

Filament won’t extrude from
the Smart Extruder.

Try unloading and reloading the filament.
You may be able to avoid jams in the future
by allowing the Smart Extruder to cool
before turning off your MakerBot Replicator.

Printed object is stuck to
the build plate.

If the object is still stuck, take a thin metal
craft spatula and carefully work the blade
under the object. When the blade is most of the
way under the object, twist the handle slightly.
The object should come free.
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Printing Problems
Problem	

Solution

Object peels off the build plate
during printing.

Relevel your build plate. Inconsistent plate height
will lead to inconsistent adhesion. If any one part
of your object does not adhere well to the build
plate, the whole object might peel off of the plate.
Ensure that the build plate is clean. Dust and oil
from your hands or tears and wrinkles in the blue
tape covering the plate can prevent objects from
adhering. Wipe down the build plate with a clean,
lint-free cloth.
If you are printing directly on blue tape, consider
using a raft. A raft provides a consistent build
surface that even tricky prints will stick to.

Touchscreen doesn’t respond.

The control panel screen on the MakerBot®
Replicator® Desktop 3D Printer is not a touchscreen.
Turn the dial to scroll through the available options
on the screen. Press the dial to select.

The plate leveling routine does
not result in a level build plate.
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The assisted leveling routine depends on a
clean, flat plate and a clean extruder nozzle.
Wrinkles in your blue tape or plastic debris on
the build plate or nozzle can interfere with the
extruder sensor.

Connectivity Problems
Problem	

Solution

Can’t access the Library,
Explore and Store sections
of MakerBot Desktop.

You may not be logged into your MakerBot account.
These features are only accessible when you are
logged in. If you are logged into your MakerBot
account but are still unable to access the Library,
Store and Explore sections, your computer may
not be connected to the internet.

The MakerBot Replicator is
connected to a network, but
MakerBot Desktop will only
allow me to export, not print.

You may not have established a connection
between MakerBot Desktop and your MakerBot
Replicator. In MakerBot Desktop, go to Devices >
Connect to MakerBot. Choose your MakerBot
Replicator from the list of MakerBot 3D printers
on your network and click Connect. When
prompted, push the dial on your MakerBot
Replicator to confirm the connection.

Filament breaks between the
spool and the MakerBot
Replicator Smart Extruder.

Open the filament drawer and ensure that the
filament unwinds counterclockwise. Check that
the filament guide tube is not twisted or bent.
Make sure to unload the filament left in the
Smart Extruder before reloading.
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Connectivity Problems
Problem	

Solution

The MakerBot Replicator Smart
Extruder is installed, but the
MakerBot Replicator does not
recognize it.

Remove the Smart Extruder and run the extruder
attachment script by going to Utilities > System
Tools > Change Smart Extruder.

Print files don’t appear in USB
storage or internal storage.

Make sure that your print files are in the appropriate
format. Print files for the MakerBot Replicator must
have a .makerbot file extension.

If these solutions don’t solve your issue, or if you are having a problem that doesn’t appear
here, please contact MakerBot Support by emailing support@makerbot.com. See page 56
for more on how to contact MakerBot Support.

49

Troubleshooting

Updating Firmware
Firmware is the software that runs on your MakerBot Replicator. Keeping your firmware up
to date will help ensure that your MakerBot Replicator is in the best possible working order.
Firmware updates allow MakerBot to add new features to your MakerBot Replicator and
improve old ones.
MakerBot Desktop will let you know if there’s a firmware update available. To upgrade to the
new version, just select Upload Firmware from the Devices menu. The software will walk
you through the steps to bring your MakerBot Replicator up to date.
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Specifications
PRINTING
Print Technology: 		
Build Volume: 		
Layer Resolution: 		
Filament: 		
Nozzle Diameter: 		
Print File Type: 		

Fused deposition modeling
25.2 L x 19.9 W x 15.0 H cm [9.9 L x 7.8 W x 5.9 H in]
100 microns
1.75 mm [0.069 in] MakerBot PLA Filament
0.4 mm [0.015 in]
.makerbot

SOFTWARE
Software Bundle: 		
3D Model File Types:
Supported OS: 		

MakerBot Desktop Software
.stl, .obj, .thing
Windows (7+), Mac OS X (10.7+), Linux (Ubuntu 12.04+, Fedora 19+)

PHYSICAL DIMENSIONS
Printer: 			
Shipping Box: 		
Printer Weight: 		
Shipping Weight: 		

52.8 L x 44.1 W x 41.0 H cm [20.8 L x 17.4 W x 16.2 H in]
57.6 L x 52.1 W x 54.6 H cm [22.7 L x 20.5 W x 21.5 H in]
16.0 kg [35.3 lbs]
17.6 kg [38.9 lbs]

TEMPERATURE:
Ambient Operating
Temperature: 		
Storage Temperature:

15-32°C [60-90°F]
0-38°C [32-100°F]

ELECTRICAL
Power Requirements:
Connectivity: 		

100-240 VAC; 0.76-0.43 A; 50/60 Hz; 100W
USB, Ethernet, Wi-Fi [coming soon]

MECHANICAL
Construction: 		
Build Surface: 		
Stepper Motors: 		
XY Positioning Precision:
Z Positioning Precision:

PC ABS with powder-coated steel reinforcement
Glass with blue tape
1.8° step angle with 1/16 microstepping
11 microns [0.0004 in]
2.5 microns [0.0001 in]

CAMERA
Camera Resolution:

640x480
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glossary
BACK BUTTON: The button at the top right
corner of the control panel’s LCD screen. The
back button will often allow you to return to
a previous screen or cancel an action.
BLUE TAPE: Blue masking tape that makes
a great build surface for objects printed with
MakerBot PLA Filament. You can ﬁnd blue
tape at any hardware store or order sheets
of blue tape sized for your build plate at
makerbot.com/store.
BUILD PLATE: The flat glass plate on which
the MakerBot® Replicator® Desktop 3D
Printer builds an object.
BUILD PLATFORM: The support for the
build plate. The build platform includes
knobs for manual leveling.
CONTROL PANEL: The LCD screen, dial
and buttons at the upper right corner of
the MakerBot Replicator. The control panel
allows you to start prints, change settings
and view status information.
DIAL: The rotary/push dial on the control
panel. Rotate the dial to scroll through
available options and push the dial to select.
ETHERNET CABLE: A Cat5e cable used to
connect your MakerBot Replicator to a local
area network.
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EXTRUDER ASSEMBLY: The MakerBot
Replicator Smart Extruder installed in the
extruder carriage.
EXTRUDER CARRIAGE: The part of the
extruder assembly that sits on the gantry
and moves back and forth. When the Smart
Extruder is installed in the extruder carriage,
the extruder assembly is complete.
EXTRUDER NOZZLE: The opening on
the end of the Smart Extruder from which
heated MakerBot PLA Filament emerges to
be spread onto the build plate.
FILAMENT DRAWER: The part of your
MakerBot Replicator that slides out to
allow you to load a spool of MakerBot
PLA Filament.
FILAMENT GUIDE TUBE: The plastic
tube that guides the MakerBot PLA
Filament from the ﬁlament spool to
the Smart Extruder.
FIRMWARE: The software that runs on your
MakerBot Replicator.
GANTRY: The apparatus that allows the
extruder assembly to move around.
INTERNAL STORAGE: The part of the
MakerBot Replicator’s onboard storage that
you can use to store print files. The capacity
of the MakerBot Replicator’s internal
storage is about 2GB.

glossary
LAYOUT: An arrangement of 3D models
on the build plate. Multiple layouts can be
saved as part of any Thing in your Library.
LEVELING KNOBS: The two knobs
underneath the build platform that allow
you to pivot the build plate around its center
point during the leveling process.
.MAKERBOT: The format of print files
for your MakerBot Replicator. Print files
contain instructions for your MakerBot
Desktop 3D Printer.
MAKERBOT ACCOUNT: The username
and password you will use to sign in
to MakerBot Desktop , and log on to
Thingiverse and other MakerBot sites.
MakerBot Cloud Library: The part
of MakerBot Desktop where you can access
your MakerBot Cloud Library and organize
your own design files, files downloaded
from or collected on Thingiverse™, or files
purchased from the MakerBot Digital Store.
MAKERBOT DESKTOP SOFTWARE:
Free software for use with your MakerBot
Replicator Desktop 3D Printer. MakerBot
Desktop will help you discover, manage,
share and print 3D models.
MAKERBOT DIGITAL STORE: A digital
store where you can download premium
3D content.
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MAKERBOT PLA FILAMENT: Polylactic
acid ﬁlament. PLA is a corn-based
thermoplastic. MakerBot PLA Filament is
the source material from which you make
objects on the MakerBot Replicator.
MAKERBOT REPLICATOR: The
MakerBot® Replicator® Desktop 3D
Printer (Fifth Generation Model).
MENU BUTTON: The button at the
bottom right corner of the control
panel’s LCD screen. The menu button
will often allow you to open a menu
containing additional options.
.OBJ: A file format used for 3D models.
PROFILE: The settings used to slice your
3D model and create a print file. MakerBot
Desktop Software comes with preset profiles
for Low, Standard and High resolution prints.
RAFT: A plastic base printed on the build
plate and used as a printing surface for your
printed object.
Settings dialog: The dialog that allows
you to change which print settings will be
used when you create a print file.

glossary
SETUP ASSISTANT: The set of tasks
that runs when you turn on the MakerBot
Replicator for the first time. The setup
assistant helps you level the build plate,
load filament and start a test print. You
can access the setup assistant at any time
through the Utilities menu.
SLICING: The process of turning a
3D model into a print file containing
instructions for your MakerBot 3D printer.
The MakerBot Replicator uses print files
with the extension .makerbot.
SMART EXTRUDER: The MakerBot
Replicator Smart Extruder draws the
ﬁlament from the spool, melts it, and pushes
it through a nozzle onto the build plate.
.STL: A widely used ﬁle format for
3D models.
SUPPORTS: Automatically generated
support structures used to prop up any
sections of a print that will not stand alone.
.THING: A file format used by MakerBot
Desktop that stores additional information
about your 3D model files.
THING: A file or group of files saved to
Thingiverse or to your MakerBot Cloud Library.
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THINGIVERSE: MakerBot Thingiverse, an
online community for sharing 3D design files.
USB CABLE: A cable that allows your
computer to communicate with the
MakerBot Replicator.
USB DRIVE: A USB flash drive. You can use
a USB drive to transfer print files to and from
the MakerBot Replicator.

How to Use MakerBot Support
At MakerBot, we take pride in offering expert, responsive, friendly customer support to all of
our customers around the world. When you email or call us, there are a few things you can do
ahead of time to help us help you.
Have your serial number ready.
The serial number helps us to quickly look up your order and get more complete information
on your MakerBot Replicator. The serial number is located on a label on the right side of your
MakerBot Replicator.
If you are contacting us via email, be as thorough as possible.
Please provide as much information as possible about your issue in your initial email.
The more information we have, the more accurately we can identify your issue.
Send a photo or video.
Many issues are easier to diagnose with photographs or videos. These kinds of issues include:
• •
• •
• •

Situations where something is physically damaged or out of place.
Situations where you believe you understand the issue, but don’t know the names 		
of the components involved.
Situations where your MakerBot Replicator is behaving in a way that may be 		
difficult to describe.
Print quality issues.

• •
•
If you don’t have a camera handy, you can always use the one on your MakerBot Replicator.
To take a photo, just go to Utilities > Camera > Take a Picture. Then copy it to a USB drive
and move it to your computer.
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Contact
Support

makerbot.com/support
Our website has extensive documentation and
troubleshooting information about your MakerBot
Replicator. It’s a great resource when you want to
try to solve issues quickly on your own.
support@makerbot.com
If you ever need help resolving an issue with
your MakerBot Replicator, send an email to
the address above to open a ticket with the
MakerBot Support Team. To help us understand
your problem from the start, it is very helpful to
include pictures or a video as attachments to
your email.

Sales

sales@makerbot.com
To learn about other MakerBot products,
including MakerBot PLA Filament, please email
the address above, or call our Sales Team at
(347) 334-6800.

Feedback

thoughts@makerbot.com
For general questions, or to tell us what’s on
your mind, send an email to the address above.
We love to hear from you, and using this email
address helps keep our Sales and Support lines
free for customers in need.

57

Reference

8

Terms

terms
Please be advised of the following terms (the “Terms”) regarding this User Manual (this “Manual”):
All information in this Manual is subject to change at any time without notice and is provided
for convenience purposes only. MakerBot reserves the right to modify or revise this Manual
in its sole discretion and at any time. You agree to be bound by any modifications and/or
revisions. Contact the MakerBot Support Team for up-to-date information.
The design of this Manual and all text, graphics, information, content, and other material
are protected by copyright and other laws. The contents are copyright 2009, 2010, 2011,
2012, 2013, 2014 MakerBot Industries, LLC, or our respective affiliates and suppliers. All
rights reserved. Certain trademarks, trade names, service marks, and logos (the “Marks”)
used in this Manual are registered and unregistered trademarks, trade names, and service
marks of MakerBot and its affiliates. Nothing contained in this Manual grants or should be
construed as granting, by implication, estoppel, or otherwise, any license or right to use any
Marks without the written permission of MakerBot. Any unauthorized use of any information,
materials, or Marks may violate copyright laws, trademark laws, laws of privacy and publicity,
and/or other laws and regulations.
DISCLAIMERS. Neither MakerBot nor any of our affiliates warrants the accuracy or
completeness of the information, products, or services provided by or through this Manual,
which are provided “as is” and without any express or implied warranties of any kind,
including warranties of merchantability, ﬁtness for a particular purpose, or non-infringement
of intellectual property. To the fullest extent permissible by the applicable law, we hereby
disclaim all liability for product defect or failure or for claims that are due to normal wear,
product misuse or abuse, product modiﬁcation, improper product selection, noncompliance
with any codes, or misappropriation. To the fullest extent permissible by the applicable law,
we hereby disclaim any and all responsibility, risk, liability, and damages arising out of death
or personal injury resulting from assembly or operation of our products. MakerBot assumes
no responsibility, nor will be liable, for any damages to, or any viruses or malware that may
infect, your computer, telecommunication equipment, or other property caused by or arising
from your downloading of any information or materials related to MakerBot products. The
foregoing exclusions do not apply to the extent prohibited by law; please refer to your local
laws for any such prohibitions. We make no warranties to those deﬁned as “consumers” in
the Magnuson-Moss Warranty–Federal Trade Commission Improvement Act.
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LIMITATIONS OF LIABILITY. In no event will MakerBot or any of our respective officers,
directors, employees, shareholders, affiliates, agents, successors, or assigns, nor any party
involved in the creation or production of our products, be liable to you or anyone else for
any indirect, special, punitive, incidental, or consequential damages (including, without
limitation, those resulting from lost proﬁts, lost data, or business interruption) arising out
of the use, inability to use, or the results of use of this Manual, whether based on warranty,
contract, tort, or any other legal theory and whether or not advised of the possibility of such
damages. The foregoing limitations of liability do not apply to the extent prohibited by law;
please refer to your local laws for any such prohibitions.
CHOICE OF LAW; JURISDICTION. These Terms will be governed by and construed in
accordance with the laws of the State of New York, without giving effect to any principles of
conﬂicts of laws. Any action seeking legal or equitable relief arising out of or relating to these
Terms or this Manual will be brought only in the courts of the State of New York or the United
States District Court for the District of New York.

Warranty. The MakerBot Replicator Desktop 3D Printer (Fifth Generation Model) is
covered by a Limited Warranty. For terms and conditions, see makerbot.com/legal
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MakerBot

One MetroTech Center, 21st Floor, Brooklyn, NY

support@makerbot.com

makerbot.com

